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1 Introduction 
This document describes the functionalities of the Evaluation Kits for the ZSSC3016, ZSSC3026, and ZSSC3036, 
referred to here as the ZSSC30x6 Evaluation Kit. Note: Most illustrations show the ZSSC3026, but the content 
applies to any ZSSC30x6 IC. This document covers the hardware components, the product specific configuration, 
the evaluation software, and its handling. The software is designed for Windows®-based operating systems to 
communicate with the ZSSC30x6 Evaluation Kit via the USB connection of the PC. 

2 Evaluation Kit Overview 
The ZSSC30x6 Evaluation Kit includes the following hardware components: 

• ZSSC30x6 Communication Board (CB)

• ZSSC3016 Evaluation Board (EB)
Note: The same ZSSC3016 EB is used for all three kits.

• Sensor Replacement Board (SRB)

• Ribbon cable for the connection between the boards (14 pin)

• ZSSC30x6 IC sample (DUT)

• USB cable for the connection to a PC

The ZSSC30x6 Evaluation Software and the documentation are available at:
• www.IDT.com/ZSSC3016KIT
• www.IDT.com/ZSSC3026KIT

www.IDT.com/ZSSC3036KIT

The kit must be connected to a master, which is typically a PC. 

The Evaluation Board provides a connector for connecting a sensor replacement device or a solder connection for 
a soldering a sensor to 4 pads.  

Schematics for the Communication Board are provided in Appendix A. Schematics for the Evaluation Board are in 
Appendix B. 

http://www.idt.com/ZSSC3016KIT
http://www.idt.com/zssc3026
http://www.idt.com/zssc3026
http://www.idt.com/ZSSC3036KIT
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Figure 2.1 ZSSC30x6 Evaluation Kit Overview 

The IC sample provided with the kit has the following package type depending on the product: 

• ZSSC3016: CDIP 18 package
• ZSSC3026: PQFN 24 package inside an adapter, which will be plugged into the CDIP socket.
• ZSSC3036: PQFN 24 package inside an adapter, which will be plugged into the CDIP socket.

2.1. Installing the Software 
The Evaluation Kit uses an FDTI controller on the Communication Board to handle the USB protocol, translate 
communications, and synchronize communications with the I2C™* and/or SPI interface. 

2.1.1. Installing the USB Drivers 
Before installing the ZSSC30x6 Evaluation Software, the USB drivers for the FTDI device must be installed. 
Download the drivers and corresponding installation guides from www.ftdichip.com/Drivers/D2XX.htm. The 
Evaluation Software accesses the FTDI controller through the D2XX DLL. The drivers will not affect the operation 
of any other USB peripherals. For installation of the drivers, the user’s system must meet these requirements: 

• x86-compatible PC
• 64 MB RAM
• Hard drive with 20MB free space
• USB port
• Windows® 2000/XP/Vista/Windows® 7/Windows® 8

* I2C™ is a trademark of NXP.

http://www.ftdichip.com/Drivers/D2XX.htm
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2.1.2. Installing ZSSC30x6 Evaluation Software 
To install the ZSSC30x6 Evaluation Software on the user’s PC hard drive after unzipping the downloaded 
ZSSC30x6 Evaluation Software zip file, navigate to the directory ZSSC30x6 EV SW_vXpxx (note: Xpxx refers to 
the latest version number). Double click on the setup.exe file and follow the resulting standard installation 
instructions, entering installation paths and identification as needed. The software automatically completes the 
installation and creates an access link under Start -> All Programs -> ZMDI -> ZSSC30x6 Evaluation if the 
defaults settings have been used. 

3 Evaluation Kit Hardware 
The delivered hardware consists primarily of two circuit boards: the ZSSC30x6 Communication Board and the 
ZSSC3016 Evaluation Board. They are connected via the 14-pin ribbon cable. The Communication Board has a 
USB interface for the connection to the master PC. The Evaluation Board has a CDIP 18 socket where the 
sample IC (a.k.a. the DUT) must be inserted. An adapter is used for ZSSC3026 and ZSSC3036 samples. 

3.1. Communication Board 
The ZSSC30x6 Communication Board has devices mounted on both sides. The components on the top side of 
the PCB generate a stable supply voltage and an optional external programming voltage. See Figure 3.1.  

There is a pin header for using a jumper to select either the I2C™ or SPI communication protocol for communi-
cation with the DUT in the socket on the Evaluation Board. The ribbon cable connector that connects the 
Communication Board to the Evaluation Board provides access to all communication signals; e.g., for an oscillo-
scope probe.  
A metal potentiometer can be used to adjust the supply voltage in the typical range from 1.7V to 3.8V. Its initial 
adjustment on delivery provides a voltage VDD ≈ 2.0V to 2.2V. The intensity of the adjacent LED is proportional to 
the supply voltage. 
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Figure 3.1 Components on the Top of the ZSSC30x6 Communication Board 
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On the bottom side of the Communication Board, the largest IC is the FTDI microcontroller for protocol handling. 
There are also voltage regulators for the two variable voltages (VDD and VPP) and level shifters for communi-
cation signals. 

Figure 3.2 Components on the Bottom of the ZSC30x6 Communication Board 

3.2. Evaluation Board 
The ZSSC30x6 Evaluation Board allows the user to use an oscilloscope to analyze all available signals to and 
from the DUT and to select the communication interface for it via a jumper, which must match the setting on the 
Communication Board. The Evaluation Board provides two alternatives for connecting a sensor or a sensor 
replacement device: via a 16-pin square sensor connection terminal or by soldering a sensor with 4 pads on it to 
an SMD footprint (see Figure 3.3). 

The K1 and K2 pin header blocks (4 pins x 9 pins) adjacent to the DUT socket allow using a 2-pin jumper to 
connect signal lines of the DUT (either of the 2 middle pins in each row of each header block) to either VSS (the 
GND trace pin adjacent to the DUT) or VDD (the outer V_TGT trace pin, which is the supply voltage generated 
from the Communication Board).  

To connect the proper supply required for the DUT, use the red jumper to connect the DUT’s VDD signal line to 
the V_TGT line as shown in Figure 3.3. Use the black jumper to connect the DUT’s VSS pin the GND line. 

Voltage 
regulator 
controller FTDI

Level shifter (USB -> SPI/I2C)USB controller

Voltage 
regulator 
VDD supply

Voltage regulator 
VPP voltage Level shifter (SPI/I2C ->USB)
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Figure 3.3 ZSSC30x6 Evaluation Board 

Note: The jumpers for the VDD and/or VSS connection might be missing on the delivered ZSSC30x6 Evaluation 
Board. In this case, please insert the jumpers on the board as shown in Figure 3.5. They are mandatory for the 
power supply for the IC sample.  

3.3. IC Orientation for ZSSC3026/ZSSC3036 Adapter 
Figure 3.4 demonstrates the orientation for the ZSSC3026 or ZSSC3036 in the PQFN package adapter required 
for proper function on the Evaluation Board.  

Figure 3.4 Orientation of the PQFN in the PQFN Adapter 
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3.4. Interface Selection 
Jumpers on the Communication Board must be set as shown in Figure 3.5. Further details for the signal path can 
be found in the schematics in Appendix A.  

The blue jumper on the Evaluation Board defines the protocol for the DUT in the following way: 

• Jumper on the “I2C” position → SEL = HIGH
For the I2C™ selection, the jumper does not need to be connected. In this case, the SEL input to the DUT
is recognized as HIGH.

• Jumper on the “SPI” position → SEL = LOW
For SPI, the interface jumper is required to pull the SEL signal to the LOW level.

Figure 3.5 Communication Interface Selection on CB and EB 
Note: Interface settings on the CB and EB must match. 
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3.5. Connectors 
The connectors on the CB and EB are labeled. The kit must be assembled by the customer. When the ribbon 
cable is connected correctly, it provides all possible signals between the microcontroller on the CB and the DUT 
on the EB. The minimum signals required are VDD, VSS, SDA, and SCL; these lines can provide all options for 
measurements and I2C™ communication. 

Figure 3.6 shows the pin assignment for the available connectors at the CB. 

Figure 3.6 Connectors and the Pin Assignments at the CB   

Figure 3.7 Connectors and the Pin Assignments at EB 

Note: The signal names on the CB and EB do not match for some signals due to different origins for the boards; 
nevertheless the actual signals are provided at the same pins at the corresponding connectors.  
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3.6. Supply Voltage 
The Evaluation Kit can be powered with an internal or external voltage supply for the DUT on the Evaluation 
Board, which must be selected with the red jumper on the K5 pin header on the CB (see Figure 3.1). There are no 
settings for selecting the supply source on the EB. 

3.6.1. Internal Supply Voltage 
The internal VDD supply is generated by a regulator circuit on the CB. It is used as the HIGH level reference for 
all signals that are necessary for communication with the DUT. If the red jumper on K5 is positioned as shown in 
Figure 3.8 (“int” setting), then the DUT on the EB is supplied internally. With this setting, no external voltage input 
is needed for the Evaluation Kit. 

Figure 3.8 Jumper Settings on Communication Board for Internal Supply Voltage 

3.6.2. External Supply Voltage 
An alternative for providing the supply voltage to the DUT is to input an external voltage supply source. Ensure 
that the external voltage does not exceed the voltage supply specifications given in the IDT data sheet for the 
DUT before connecting to the Evaluation Kit. 

To use an external supply, set the K5 jumper as shown in Figure 3.9(“ext” setting). Connect the external voltage 
to the 2-pin V_ext header that is immediately to the right of the K5 jumper with the orientation shown in Figure 3.9. 
There are no adjustments for the external voltage on either the CB or EB. 
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Figure 3.9 Jumper Settings on Communication Board for External Supply Voltage 
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4 Evaluation Kit Software 
When the ZSSC30x6 Evaluation Software (GUI) is activated, the left side of the first screen is the General tab, 
which provides basic communication status (see Figure 4.1). The largest section of the screen is the main graph 
area on the right, which is for displaying the measurement results over time. The data scale for temperature 
output is on the right side of the main graph; the scale for bridge measurements is on the left. The x-axis 
represents the number of measurement points at a given value in a run. Both y-axes display the corresponding 
bridge/temperature value in a format selectable by the user. 

Figure 4.1 GUI View after Opening the Evaluation Software 



ZSSC30x6 Evaluation Kit Description      

© 2016 Integrated Device Technology, Inc. 14 April 1, 2016 

4.1. Top Menu GUI Controls 
At the top of the GUI screen is a banner for GUI controls that are always available. These include display fields at 
the left for real-time single bridge and temperature measurement results. There are also additional controls with 
the following descriptions and functions: 

Table 4.1 Basic GUI Controls 

Control Description 

Port button 

The Port button allows closing and opening the USB communication port. This is useful 
for making hardware changes (e.g., switching the DUT or jumper settings) without 
exiting the GUI. It also indicates the current status. The button is green only if proper 
communication has been established. 

Status display field The Status display field shows information related to the current GUI operation; e.g., if 
calculated coefficients exceed the defined limits, the Status field displays the error. 

Power On/Off icon 

The Power On/Off icon indicates whether the supply voltage is applied to the DUT in 
the socket on the EB. 

average values checkbox 

Select average length slider 

Checking the average values checkbox activates averaging of the measurement 
results. The Select average length slider determines the number of measurements that 
are taken to calculate the average result, which will then be displayed in the display 
fields for measurement results and the main graph. Averaging extends the time until 
the results appear in the GUI by the factor of adjusted average values. The results are 
displayed in color instead of black font. 

Bridge graph/ Temp. graph 
slider bars 

The output type for measurement results can be chosen or the associated graph can 
be switched off with the Bridge graph and Temp graph slider bars. Raw measurements 
are only provided in counts. After calibration, the °C- and the %- display are available. 
[N] – Displays measurement results in counts.
[deg. C] – Displays measurement results in degrees Celsius. This option is only 
available in Normal Mode where the measurements are linearized by coefficients. 
[%] – Shows measurement results in percent, in relation to full-scale output (FSO) 
(65535). 
Off – No display of results for the associated graph 

log communication checkbox 

For some purposes such as debugging or documentation, it is helpful to log the 
master-slave communication. To record this data, activate this checkbox, which results 
in a dialog window for selecting the name and location for a .txt file where this informa-
tion will be written. After the .txt log file is set up, it can be opened in the menu bar:  
File->Communication Log 
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Control Description 

This button activates a cyclic bridge and/or temperature measurement. The 
measurement mode is defined by the Raw / DSP Corrected measurement mode slider 
bar to the left of this button. 

Measurement Mode Slider 

Raw measurements must be configured either via the External Configuration section 
under the EXT tab (see section 4.7), which is the recommended method, or by directly 
writing a configuration into the BM_Config register. The raw data output provides the 
results directly after AD conversion. 
DSP Corrected position of the slider selects the configuration from the BM_Config 
register for the measurement. The digital result after the ADC will be then processed 
with the calculated coefficients. This measurement mode will provide valid results only 
after a valid calibration of the ZSSC30x6. 

Conversion Time 

This field indicates the period that is needed to complete a measurement command. 
This period is defined by the conversion time of the ADC, the IC processing time, and 
communication time between master and slave. Depending on the MSB/LSB 
segmentation settings, the conversion time can vary significantly. The default value of 
200ms suffices to establish an auto-zero-corrected measurement with a MSB/LSB 
segmentation of 14/2. The conversion time can be derived from the ADC conversion 
times specifications given in the ZSSC30x6 Data Sheet. 

This button requests and reads the ZSSC30x6’s status byte and displays the result on 
the LEDs on the General tab. 

Reads the complete contents of the multiple-time programmable (MTP) memory of the 
ZSSC30x6. The decoded basic bridge configuration and the I2C™ address are 
displayed on the General tab. 

This button activates writing to the MTP of the ZSSC30x6. It will write only the 
addresses for which the content is shown in red font on the MTP tab. In addition to 
using the automatic data transfer from the Calibration tab and General tab, users can 
also edit the values by double clicking on the value on the MTP tab page. The 
ZSSC30x6 must be in Command Mode (CM) in order to write to the MTP; therefore the 
software performs a power-on >power-off >Start CM sequence in the background. 
After the write operation, the ZSSC30x6 will be set into Normal Mode again. 

4.2. Measurement Color Code 
Bridge and temperature results are displayed in different colors. Different colors are also used for single and 
averaged measurement results: 

Table 4.2 Color Code for Bridge and Temperature Results 

Color Indication 

Pink Single bridge measurement. 

Light Blue Single temperature measurement. 

Blue Averaged bridge measurement. 

Green Averaged temperature measurement. 

Red Invalid measurement result. This could be due to a Conversion Time that is too short. In this case, bit 5 in 
the status byte is set to ‘1’ and the Busy virtual LED on the General tab turns on. Another reason for an 
invalid measurement result could be if ALU saturation is detected. In this case the Saturation LED turns on. 
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4.3. GUI Menu Bar 
Figure 4.2 shows the submenu items that are accessible under the menu bar of the GUI. 

Figure 4.2 Structure of the GUI Menu Bar – ZSSC3026 Example 

The File menu allows selecting options to load or save the MTP configuration and options for logging measure-
ment data and communication data. 

4.3.1. Save/Load MTP Register Contents 
Initially the customer memory pages are empty. If an identical memory configuration is needed for multiple ICs, it 
is possible to save a given setup as a template. When the required MTP content is present in the MTP tab, select 
File > Save MTP Config. The configuration file is created with an .eep extension, and it contains one decimal 
value for each MTP address in each row.  
To load a configuration file, select File > Load MTP Config. Note: The decimal values will be automatically dis-
played as hexadecimal values in the MTP tab. The loaded data is displayed in red font in the MTP tab and can be 
written into the memory. 
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4.3.2. Scan I2C™ Bus via the Scan I2C address Feature 
Another feature provided in the menu bar is the ability to scan the I2C™ bus to determine the I2C™ address of the 
ZSSC30x6. Selecting Scan I2C address triggers the scan during which the ZSSC30x6 status is requested for 
each address ranging from 00HEX to 7FHEX. When an I2C™ address is acknowledged by the ZSSC30x6, the scan 
stops, and this address is used for further communication during the current GUI session. The results of the scan 
are indicated in the status window: 

• Status window message for a successful I2C™ scan: Valid I2C address found: 0xXX!
• Status window message for an I2C™ scan without slave acknowledge: No valid I2C address found!

The I2C™ address information is lost if the GUI or the communication port is closed. The communication to the 
ZSSC30x6 with an I2C™ address other than 00HEX can also be established by typing it manually in the menu bar 
item interface setup by selecting Interface Setup > I2C Slave Address. 

4.4. GUI – General Tab 
Table 4.3 General Tab –Displays and Controls 

Control Description 

After reading the MTP, the display shows the I2C™ address that is saved in the memory. If a 
new address is entered in the window and the Copy adjusted settings to MTP button is 
clicked, the new value is shown in red color on the MTP tab. 

The bridge configuration area provides settings of the analog signal path and AD conversion. 
The drop-down menus contain the available setting values. 
Changing the parameter values here does not automatically apply them to measurements. It 
is possible to apply the adjusted settings and use them for raw data collection. There are 
different commands for performing raw measurements. Some of the commands use the con-
figuration from the BM_Config register (A0HEX, A2HEX); others (A1HEX, A3HEX) are configured 
via the interface. For a full description of raw measurement commands, refer to Table 4.4. 
For configuration via the interface, click on the Copy adjusted settings for Raw Data Acquisi-
tion button, which automatically displays the EXT tab (see section 4.7) and transfers the 
present settings to the external configuration section. 
The Copy adjusted settings to MTP button copies the present settings to the MTP tab. The 
settings can then be written to the MTP memory (see section 4.6). 

The communication status section evaluates the status byte information sent from the sample. 
It provides following information via the virtual LEDs: 
Powered indicates if the device is powered. If the LED is off, it does not automatically mean 
that VDD is not supplied. For example, the LED will be off if the I2C™ communication is 
attempted with an I2C™ address different from the address programmed in the IC’s memory. 
CMD Mode shows whether the IC is in Command Mode. 
Test Mode shows whether the IC is in Test Mode (not intended for users) 
Busy indicates if processing of the last command is finished. If it is, the LED is off. 
Memory Error displays whether the checksum-based integrity check passed or failed. In the 
default state of the kit, this LED should be on. Recommended approach: after writing memory 
data (bridge configuration, coefficients…), write the signature over the memory content via the 
MTP Write Completion (Checksum) button on the MTP tab. After a subsequent power-on-
reset sequence, the integrity check should pass and the LED should turn off. 
Saturation: This LED is on if the DSP core saturates; e.g., if the internal signal correction 
result exceeds the limits of the internal arithmetic unit. 
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4.5. Data Logging 
The ZSSC30x6 Evaluation Kit software provides the option to log measurement and communication data as 
described in Table 4.1. 

4.5.1. Communication Log 
Communication with the IC can be logged for both the I2C™and SPI interface. Use the log communication 
checkbox on the General tab for recording the data stream. Choose a path for which the user has writing 
permission for storing the log file. Open the log file via the menu bar: File -> Communication Log. The resulting 
text file is an ASCII file and can be imported into Microsoft® Excel. 

4.5.1.1. I2C™ log 

Figure 4.3 shows a short example of the I2C™ communication recorded in a log file. 

Figure 4.3 I2C™ Communication Example 

The log file maps only the transferred data, not the specific frame conditions for I2C™, such as START or STOP 
conditions or acknowledges. Communication commands that are not available to the user are not logged. This 
also applies to the SPI communication log. 
The Evaluation Kit uses DF 5 (data fetch 5) by default. This means READ data from the slave has a 5-byte 
structure. In the example shown in Figure 4.3, a raw bridge measurement is done in two steps: 

• Start Command Mode (A9HEX). After this command, it is not necessary to read; however, the Evaluation Kit
software sends a command to read the status byte to obtain the most current status of the IC. In the
second and fourth rows of the example above, the status byte of 4c is returned in the response to the
master sending the slave address with the read/write bit (R/ ) set to read.

• Get_Raw auto-zero corrected bridge data (A3HEX).

I2C™ interface properties correspond to the NXP I2C™ bus specification. For the I2C™ log example data, the 
sections of the data frame structure are explained in Figure 4.4. In this illustration for communication frames, 
START conditions are indicated with S; STOP conditions are shown as P; and acknowledges are shown with A. 
For information about communication frame structure, see the data sheet (see section 6). 
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Figure 4.4 I2C™ Communication Structure for Example Communication Log 

4.5.1.2. SPI Log 

Communication via SPI is accomplished with the single pins for input and output (MOSI and MISO respectively). 
The MOSI data always consists of 3 bytes; MISO data is always 5 bytes. 
The example shown in Figure 4.5 has the same command sequence as the I2C™ example. The difference is the 
F0HEX command, which is sent in the Evaluation Kit each time before reading the MISO signal. This is due to 
IDT’s hardware/software setup for the kit. It is not required for the final user application. 

Figure 4.5 SPI Communication Example 

data frame (hex) 00 a3 02 48 end

0000000 0 10100011 00000010 01001000Data in bits

I2C frame

Read data from slave by master
data frame (hex) 01 4c e0 0a 00 00 end

0000000 1 01001100 11100000 00001010 00000000 00000000

Measurement configurationCommand

Status Measurement result

Write command from master to slave
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4.5.1.3. Measurement Log 

Measurement data can be recorded as well. In raw measurement mode, the results are logged in counts, but they 
are not calculated as percentage (bridge) or degree Celsius (temperature). If the IC is calibrated, the DSP-
corrected bridge results are provided in counts and percentage based on the output range. The temperature 
results are logged in counts and degree Celsius numbers. 

4.6. GUI – MTP Tab 
The MTP tab shows the current memory data of the user’s page. The data is displayed in four hexadecimal digits 
for each of the 24 addresses in the MTP. To display the memory contents in the MTP table, read the complete 
memory by clicking on the Read MTP (all) button. The resulting message in the status window at the top right of 
the GUI should be “MTP Read OK.” Subsequent changes in this table are indicated with red font so that the user 
is aware that this data does not correspond with the IC’s data.  

As shown in Figure 4.6, the first column is the address number; the second column comprises the data in the 
register. The description name for the corresponding register is given in the third column. The forth column is a 
single digit, which indicates whether an internal data correction has been asserted. Each 16-bit register displayed 
is also written to a redundant register. With each reading process, the origin and the redundant register are 
compared bitwise. If they do not agree, the correction bit in the fourth column will be set. 

Figure 4.6 User-Accessible Memory, Addresses 00HEX through 17HEX 

MTP addresses

Changed register content

MTP data
Register name

Correction bit
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Clicking the MTP Write Completion (Checksum) button at the bottom of the MTP tab triggers the signature 
generation and writing over the current memory contents. Therefore it should be the last step to be done after 
bridge measurement configuration, coefficient calculation, and writing. Once the checksum has been written, the 
Memory Error LED turns off after repowering the IC (see Table 4.3). 

Additional features on the MTP tab are the user memory page number and the INC CUST Page button for 
increasing the memory page. Each IC provides four customer pages; therefore it is possible to increase the CUST 
Page index three times. 
For the MTP write(sel), MTP Write Completion (Checksum), and INC CUST Page buttons, the IC must be in 
Command Mode, so the Command Mode is accessed and then exited by the software in the background. 

4.7. GUI – EXT Tab 
The EXT tab is divided into two sections. The upper tab area is for communication with the IC with single 
commands selectable from the drop-down menu. This section is considered as an additional communication 
option but it is not necessary for typical user purposes. The lower part of this tab is relevant for the external bridge 
configuration and temperature. “External” in this context means that the configuration does not have to be written 
to the memory. It can be transmitted with the measurement command over the communication interface. All 
commands defined in the EXTERNAL CONFIGURATION section are Get_Raw measurement requests. 

Figure 4.7 Tab for Externally Defined Communication 

Direct command section

Raw measurement configuration section
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In the “Bridge” and “Temperature” sections, the Type window defines the Get_Raw command and the Data 
window selects the measurement configuration if required. 
Example: In the “Bridge” section, an entry of 0x3 in the Type field and 0x024A in the Data field corresponds to the 
GetRaw command 0xA3 024A. 

4.7.1. Get_Raw Commands 
Eight Get_Raw commands for data acquisition are available, depending on the measurement type and the source 
of the configuration; however, there are basically only two different commands: the single measurement and the 
auto-zero measurement, which selects the ADC offset. These are applied to the bridge and temperature 
measurements with different configuration origins.  

All measurement command options are described in the Table 4.4. 

Table 4.4 Get_Raw Commands 

Command Measurement AFE Configuration Register 

A0HEX + 0000HEX BM – Bridge Measurement BM_Config 

A1HEX  + ssssHEX BM – Bridge Measurement ssss is the user’s configuration setting for the 
measurement provided via the interface. The 
format and purpose of configuration bits must 
be consistent with the definitions given in the 
BM_Config register. 

A2HEX  + 0000HEX BM-AZBM – Auto-Zero corrected Bridge 
Measurement  

BM_Config 

A3HEX  + ssssHEX BM-AZBM – Auto-Zero corrected Bridge 
Measurement 

ssss is the user’s configuration setting for the 
measurement provided via the interface. The 
format and purpose of configuration bits must 
be equal to the definitions for BM_Config. 

A4HEX  + 0000HEX TM – Temperature Measurement IDT-defined register. 

A5HEX  + ssssHEX TM – Temperature Measurement ssss is the user’s configuration setting for the 
measurement provided via the interface. The 
format and purpose of configuration bits must 
be consistent with the definitions given in the 
BM_Config register for temperature 
measurements (bits [15:13] will be ignored). 

A6HEX  + 0000HEX TM-AZTM – Auto-Zero corrected Temperature 
Measurement IDT-defined register. 

A7HEX  + ssssHEX TM-AZTM – Auto-Zero corrected Temperature 
Measurement 

ssss is the user’s configuration setting for the 
measurement provided via the interface. The 
format and purpose of configuration bits must 
be consistent with the definitions given in the 
BM_Config register for temperature 
measurements (bits [15:13] will be ignored). 
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4.7.2. Data Output Range 
Raw measurement results display AD-converted data, without passing through the digital signal processor (DSP). 
Here, the ADC offset adjustment and the measurement methods determine the raw data output range. The 
expected output range is dynamically shown in the GUI, below the configured parameter of the EXT tab. 

Output data in Normal Mode is digitally compensated and adjusted to the full-scale output of 16 bits if the device 
has been calibrated correctly. 

Table 4.5 Data Output Ranges 

Raw Modes Input Range ADC 
Offset 

Data Output 

Min Max 

BM – Bridge Measurement 

-1/16 to 15/16 1/16 0 61439 

… … 

-8/16 to 8/16 8/16 0 32767 

AZBM – Auto-Zero Bridge Measurement 

-1/16 to 15/16 1/16 -4096 61439 

… … 

-8/16 to 8/16 8/16 -32768 32767 

TM – Temperature Measurement 

-1/16 to 15/16 1/16 0 61439 

… … 

-8/16 to 8/16 8/16 0 32767 

AZTM – Auto-Zero Temperature Measurement 

-1/16 to 15/16 1/16 -4096 61439 

… … 

-8/16 to 8/16 8/16 -32768 32767 

Normal Mode 

-1/16 to 15/16 1/16 0 65535 

… … 

-8/16 to 8/16 8/16 0 65535 
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4.7.3. Setting up the Bridge Configuration for Calibration 
If the sensor characteristics are known, the bridge measurement settings can be defined in the General tab. 
These parameters are 

• Bridge Gain: The analog gain is realized in two different amplifier stages. The possible gain factors of
these two stages are selectable in the drop-down menu. Recommendation: Choose the bridge gain as high
as possible in order to take full advantage of the ADCs’ dynamic range.

• Bridge Polarity: The IC has the capability to switch the polarity of the sensor input INP and INN. This
setting is only valid if the differential sensor signal has a higher negative voltage output range than the
positive one:

if ( abs(Vmax) < abs (Vmin)) )  Bridge Polarity = 1 
else Bridge Polarity = 0 

• Bridge ADC segmentation: A second-order charge-balancing analog-to-digital converter (ADC) is used to
convert the amplifier signal. To allow optimizing the trade-off between conversion time and resolution, the
conversion is split into a MSB coarse conversion and an LSB fine conversion.

• Bridge Range Shift: Depending on the sensor output, the ADC can be adjusted by a programmable offset
from 1/16 to 8/16 of ADC’s reference voltage.

The most appropriate gain (and offset) setup for a specific sensor element can be determined by using the 
following steps: 

1) Collect the sensor element’s characteristic, statistical data (over temperature, ambient sensor parameters,
and production tolerances):

a. Minimum differential output voltage: Vmin 
b. Maximum differential output voltage: Vmax 

2) If Vmin and Vmax have different signs (normally: Vmax is positive and Vmin is negative), then the required
ADC offset shift can be selected using the ratio: RatioOffset = |Vmin| / (Vmax – Vmin)
Then, the respective offset setup (A2D_offset) is the nearest integer of multiples of 1/16 in the range of
1/16 to 8/16 (refer to the data sheet; see section 6): A2D_offset = Round_to_x16th{RatioOffset}.

3) Determine which of the two following cases is valid, with Vref = Vrefp – Vrefn = 0.94·VDDB,min ~ 1.5V:

a. If RatioOffset – A2D_offset ≤ 0 then calculate the theoretical optimum gain:
Gainopt =(1 – A2D_offset)  Vref / Vmax

b. If RatioOffset – A2D_offset > 0 then calculate the theoretical optimum gain:
Gainopt = A2D_offset  Vref / |Vmin|

4) Select the setup gain (Gainsetup) as the nearest gain to Gainopt where Gainsetup ≤ Gainopt.



ZSSC30x6 Evaluation Kit Description      

© 2016 Integrated Device Technology, Inc. 25 April 1, 2016 

After setting up the bridge measurement configuration in the General tab, it can be assigned to the EXT tab via 
the Copy adjusted settings for Raw Data Acquisition button. The bridge settings appear now coded as a hexa-
decimal 16-bit number in the Data window of the “Bridge” section (see Figure 4.8). The configuration entered here 
is valid for further calibration processes. 

Figure 4.8 External Bridge Measurement Configuration 
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4.8. GUI – Calibration Tab 
The primary purpose of the Calibration tab is the overview of the calibration data and the resulting coefficients. 
This tab is divided in two sections: the input and the output of the calibration process (see Figure 4.9). 
Figure 4.9 Calibration Tab Structure  

Calibration output: coefficients

Calibration point distribution 
in the measurement range

Calibration temperature range definition

Calibration input:  - calibration type
- calibration table with measurement points
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4.8.1. Calibration Input 
The data input section is located in the lower left of the Calibration tab. In this table, data points are defined with 
their reference information for bridge and temperature and the corresponding measurement results. Above the 
calibration point table, the calibration type can be selected in a drop-down menu. Available calibration types are 
described in Table 4.6. 

Table 4.6 Calibration Types 

Type Calculated Coefficients 
Number of Data 
Points Required 

Bridge Temp 

2 Point OFFSET_B, GAIN_B 2 0 

3 Point OFFSET_B,GAIN_B, SOT_B 3 0 

3 Point OFFSET_T,GAIN_T, SOT_T 0 3 

4 Point OFFSET_B, GAIN_B, TCO, TCG, OFFSET_T, GAIN_T 2 2 

5 Point OFFSET_B, GAIN_B, TCO, OFFSET_T, GAIN_T, SOT_TCO, SOT_B, SOT_T 3 3 

6 Point OFFSET_B,GAIN_B, TCO, TCG, OFFSET_T, GAIN_T,SOT_TCO,  SOT_TCG, SOT_T 2 3 

7 Point OFFSET_B,GAIN_B, TCO, TCG, OFFSET_T, GAIN_T,SOT_TCO, SOT_TCG,SOT_T, 
SOT_B 3 3 

Depending on calibration type, the corresponding number of calibration points are displayed in the main graph to 
indicate the coverage of the measurement range. The “Calibration Points” table contains the relevant points for 
coefficient calculation. 

Entry descriptions for the calibration table: 
P[%] – P stands for the bridge sensor measurement. The point should be entered as a percent of the full 
measurement range for the bridge sensor measurement. 
P[N] – Raw bridge measurement result in counts. 

T[°C] – Temperature in degree Celsius. 
T[N] – Raw temperature measurement result in counts. 

Example: If the final application is specified from 800 to 1200 mbar, then 5% is 820 mbar and 95% is 1180. 
Assuming the temperature range is from –40 to 80 degree Celsius, the initial calibration table for a 7-point 
calibration could be defined as it is shown in Figure 4.10. 
Note: The definition of the temperature range in the calibration must be entered at the bottom of the Calibration 
tab. The degree Celsius entries in the “Calibration Points” table must match the range definition. 
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Figure 4.10 Calibration Point Definition 

4.8.2. Calibration Output 
The upper left section in the Calibration tab is the coefficient table, where the coefficients are displayed after 
calculation. If one of the coefficients exceeds the range limit, its value appears as a red number. In this case, the 
status window displays “Coefficients Range ERROR!” 
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4.8.3. Calibration Process 
The following process for data collection describes one measurement point acquisition, representative for all 
calibration points. A detailed description for the calibration flow can be found in the document ZSSC30x6 
Application Note – Calibration Sequence and DLL (see section 6). 

Table 4.7 Calibration Data Collection 

Step Description Location 

1 Connect the Evaluation Board to a PC and make all necessary connections from the 
Evaluation Board to the ZSSC30x6 IC. 

2 Start the Evaluation Software. 

3 Create a calibration setup for the user’s system that is consistent with the sensor’s 
characteristics. Click the Copy adjusted settings for Raw Data Acquisition button to enter 
the current configuration in the EXT tab as described in Figure 4.8. 
Alternatively, a pre-defined default setup can be loaded (see section 4.3.1). 

General tab 

4 Ensure that the default and recommended measurement types (command) for data 
acquisition are selected: 
Bridge: GetRaw Type: 3 
Temperature: GetRaw Type: 6 

EXT tab 

5 Choose the calibration type via the Type drop-down menu. Calibration tab 

6 Set up the desired bridge sensor and temperature conditions so that the measurement 
can be performed in a stable state. Enter the reference conditions P[%] and T[°C] in the 
corresponding rows in the Calibration Points table. 

Calibration tab 

7 Select the row where the present measurement data should be entered by clicking one 
of the row numbers from 1 to 7. Click on the Get Point P[N], T[N] button to trigger a 
single measurement. The measurement results will be automatically displayed the table 
(see Figure 4.11). 

Calibration tab 

8 The data for the remaining calibration points must be filled in the table by repeating the 
steps 6 and 7 for each point. 

Calibration tab 
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Figure 4.11 Measuring a Calibration Data Point 

After the calibration point acquisition is completed, the coefficients calculation can be performed. Completion of 
the calibration process is described in the following steps. Figure 4.12 illustrates these steps with blue arrows. 

Table 4.8 Calculate and Write Coefficients 

Step Description Location 

1 Calculate the coefficients via the Calculate Coefficients button. The coefficients will be 
displayed in the “Calculation Coefficients” table. Calibration tab 

2 Transfer the new coefficients to the MTP table by clicking on the Put Coefficients button. The 
values are concurrently selected for writing (turning red). Calibration tab 

3 
For DSP-corrected bridge measurement, the BM_Config register must contain the same 
configuration as during calibration, so click on the Copy adjusted setting to MTP button. The 
coded configuration appears red-colored in BM_Config. 

General tab 

4 Write the new coefficients into the MTP via the Write MTP(sel). Read the MTP contents to 
ensure that the coefficients have been written to the memory. MTP tab 

First row selected

Trigger measurement
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Step Description Location 

5 
The final step after a successful calibration and coefficients writing is to generate and write 
the checksum over the user memory. The MTP Write Completion (Checksum) button triggers 
the IC internal calculation of the checksum and writes it in the Signature Cust register. 

MTP tab 

6 
Finished! After the next reset of the IC, the new coefficients will be used to calculate the 
output values if the measurement mode slider is switched to the DSP Corrected position. In 
the General tab the Memory Error LED is off. 

Figure 4.12 Coefficient Calculation 

Collected data for calibration
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5 Sensor Replacement Board (SRB) 
In addition to the Evaluation Kit, a sensor replacement board 
can be ordered. It allows the customer to do the first steps with 
the ZSSC30x6 without a final application sensor module. The 
sensor replacement board consists of two potentiometers 
between the positive and negative sensor line, which can be 
adjusted to represent the change in resistance of a sensor. 
One is for the coarse resistance regulation; the other for the 
fine adjustment. See Figure 5.1. 

The SRB has an internal resistance of approximately 2kΩ. The specific resistance values between the single pins 
are given in Figure 5.2. 

Figure 5.2 Resistance Network of the SRB 

Figure 5.1 Sensor Replacement Board 
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6 Related Documents and Files 
ZSSC30x6 Documents 

ZSSC3016 Data Sheet 

ZSSC3016 Feature Sheet 

ZSSC3026 Data Sheet 

ZSSC3026 Feature Sheet 

ZSSC3036 Data Sheet 

ZSSC3036 Feature Sheet 

ZSSC30x6 Application Note – Application Circuits 

ZSSC30x6 Application Note – Calibration Sequence and DLL 

Visit the following ZSSC30x6 product pages on IDT’s website www.IDT.com or contact your nearest sales office 
for the latest version of these documents: 

• www.IDT.com/ZSSC3016

• www.IDT.com/ZSSC3026

• www.IDT.com/ZSSC3036

7 Glossary 
Term Description 

A2D Analog-to-digital 

ACK Acknowledge (interface’s protocol indicator for successful data/command transfer) 

ADC Analog-to-Digital Converter or Conversion 

AZ Auto-Zero (unspecific) 

AZS Auto-Zero Measurement for Sensor Bridge Path 

AZT Auto-Zero Measurement for Temperature Path 

CDIP Ceramic Dual-Inline Package 

CLK Clock 

DF Data Fetch (this is a command type) 

DLL Dynamic-Link Library 

DUT Device Under Test 

DSP Digital Signal Processor (digital configuration, calibration, calculation, communication unit) 

FSO Full Scale Output (value in percent relative to the ADC maximum output code; resolution dependent) 

LSB Least Significant Bit (“fine” portion of the converted signal) 

http://www.idt.com/
http://www.idt.com/zssc3016
http://www.idt.com/zssc3026
http://www.idt.com/zssc3036
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Term Description 

MSB Most Significant Bit (“coarse” portion of the converted signal) 

MTP Multiple Time Programmable 

NACK Not Acknowledge (interface’s protocol indicator for unsuccessful data/command transfer) 

PCB Printed Circuit Board 

POR Power-On-Reset 

PQFN Power Quad Flat No Leads 

SM Signal Measurement 

SOT Second-Order Term 

SRB Sensor Replacement Board 

TM Temperature Measurement 

8 Document Revision History 
Revision. Date Description 

1.00 January 18, 2014 First release 

1.10 September 29, 2014 Addition of jumper setting information. 
Update for imagery for cover and headers. 
Minor edits for clarity. 
Update for contact information. 

April 1, 2016 Changed to IDT branding. 

http://www.idt.com/
http://www.idt.com/go/sales
http://www.idt.com/go/support
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Appendix A: Schematics Communication Board 
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Appendix B: Schematic Evaluation Board  
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